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A Fond Farewell to Brenda Hanning
By Yvette Pittman, current fellows, and former fellows of NICHD

The NICHD Office of Education was 
established in 2004 and has been 
thriving ever since. Brenda Hanning’s 
vision and passion have been the driving 
forces to achieve its mission every 
year—to support the training needs of 
our intramural scientists, fellows, and 
students at all levels. Countless lives have 
been positively impacted through her 
12 years of service at NICHD, and we will 
forever be grateful for the knowledge she 
has imparted to us. Brenda’s influence 
carries on through our successes in 
various scientific careers. Whether it was 
one-on-one career counseling sessions 
she conducted or the many personal 
statements she has edited, Brenda was 
always supportive, encouraging, and 
truthful—wanting fellows to be prepared 
for what’s ahead in their careers.

Because of her strong commitment to training, the Division of Intramural 
Research has had 12 annual Fellows’ Retreats, offered 11 series of our postbac 
course “Being an Effective Scientist,” given 18 Mentor of the Year Awards, and 
published 79 issues of The NICHD Connection. She has also created new training 
initiatives related to science communication, interviewing, grant writing and 
review, teaching, and lab management while providing numerous resources so 
every fellow can build a portfolio of skills and abilities. In order to encourage 
grantsmanship, and in support of our career development, Brenda initiated the 
Fellows Intramural Grants Supplement Award. Moreover, she has been actively 
involved in the NICHD Developing Talent Scholars and Fellows Recruitment 
Incentive Award programs. Both were recently launched to promote the 
diversity in the scientific workforce, recruiting trainees from backgrounds 
underrepresented in science.

Brenda Hanning has truly made a difference in DIR and the Office of Education 
will diligently work to continue all of her efforts.  

Brenda Hanning
PHOTO: ALEJANDRA VALLEJO

(continued on page 3)
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Letter from the Editor
With the warmest wishes, I offer a fond 
farewell to Brenda Hanning as she retires 
from 12 years of service with the NICHD. 
Throughout my time as an undergraduate 
student, graduate student, and postdoc, I 
have never met another person who cares 
more about the wellbeing and success of 
individuals in the scientific community. 

On a personal note, I owe a large part of 
my own career successes to Brenda. Her 
willingness to help establish this newsletter 
allowed me to realize my love of writing 
and editing in this format. Brenda not only 
found existing opportunities for fellows to 
pursue professional activities, she made
opportunities available. 

The NICHD Office of Education, under the 
leadership of Brenda, has been paramount 
in aiding fellows with exposure to today’s 
varied employment opportunities for 
scientists. Fellows who have benefited from 
Brenda’s expertise are now policy makers, 
school principals, professors, principal 
investigators, program directors, industry 
scientists, writers, editors, and more!   

I hope that as we all read the farewell 
comments from former fellows, we can 
realize the impact a single person can have 
on so many lives. Brenda’s actions and 
thoughtful contributions to the NICHD will 
carry on in infinite ways. May we all strive 
to make impressions as impactful and 
meaningful as Brenda has.

As we say our farewells, we also have a few 

hellos. We are happy to profile our newest 
principal investigator, Dr. Katie Drerup, 
and we welcome several new NICHD 
Fellows—from the postbaccalaureate to 
the postdoctoral level of training. 

For a special bonus, Jeremy Swan has 
prepared another how-to article for “The 
Arts” column. What could be more fitting 
for an end-of-year issue than a tutorial 
on making time-lapse movies using your 
microscopy data? This is a must read article 
if you are planning to study development 
over a long period of time.

Looking ahead, be sure to check out the 
Three-minute-Talk (TmT) announcement
for next year’s competition and this 
month’s announcements and events. And 
of course, save the date to celebrate Brenda 
Hanning’s career—please join the party on 
January 6, from 3:30 – 4:30 p.m. in Building 
31, room 6C6. 

Thank you to all of the fellows who helped 
make The NICHD Connection a great 
newsletter throughout 2016. I’ll never tire 
of saying this publication is for you and by 
you. I’m looking forward to another year of 
working with this highly talented group of 
individuals.   

Your Editor in Chief,
Shana R. Spindler, PhD

Have ideas for next year? Please send all of 
your questions, comments, and suggestions 
to Shana.Spindler@gmail.com.
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(continued from page 1)

Brenda, we honor your service and best wishes on your retirement. 
It’s so well deserved! Enjoy our library of sentiments from current 
and former intramural scientists, expressing their gratitude.

Your impact reaches far!

“This is the best job 
at NIH, working on 

behalf of the fellows.”
Brenda Hanning

Rim Mehari and Fady Hannah-Shmouni
NICHD Postbac Rep and Clinical Postdoc Rep, respectively

We would like to take a moment to cherish our times 
together. We have enjoyed working with you and 
appreciate having had this wonderful opportunity 
to learn from you. Thank you for all the support you 
have provided us during the past years. Through 
your encouragement and guidance we have been 
able to excel at various projects. Your constant 
positivity and love for science and education is 
contagious and has made a tremendous impact on 
our NIH community. With you, we have shared a 
unique camaraderie, which we hope will continue in 
the years to come even though you shall not be here 
with us. We wish you well on your next endeavor, 
which will be challenging, although in all honesty 
sure sounds pretty awesome! Yes, retirement. 
Something we look forward to as well, someday…

Prasanna Satpute-Krishnan
Assistant Professor,

Uniformed Services University of the Health Sciences

Brenda guided me through my stickiest and trickiest 
moments as a postdoc. Looking back, I think she was 
integral in my success. She is 100% genuine and I 
can't help but smile whenever I think of her.

Thomas Miller
Scientist I, Meso Scale Diagnostics, LLC

Brenda was instrumental in providing opportunities 
to grow my resume beyond laboratory techniques 
and publications, enabling me to gain a position in 
my chosen profession. I am incredibly thankful for 
her assistance, sincere caring, and sage advice.

Sydella Blatch
Associate Professor of Biology, 

Stevenson University

If not for Brenda I would not have 
gotten my postdoc! She was so positive 
and welcoming when I met her, I felt 
like I was making a good choice in 
going somewhere where she would be 
resource outside of my lab. Brenda still 
is a mentor to me today, years later as 
an Associate Professor.

Alex Szatmary
Visiting Assistant Professor, Department of

Mechanical Engineering, Bucknell University

Brenda has been an advocate for the 
NICHD Fellows Retreat. Through going 
to the retreat, I was able to talk with 
a faculty member at a predominantly 
undergraduate institution (PUI). I'm 
currently teaching at a PUI and finding 
this experience to be a great fit for my 
personality. Without Brenda, I don't 
know that I'd have found a job that I love 
as much as the one I'm doing right now.

At one of the retreats, out of concern for 
us fellows, Brenda provided information 
on resources for wellbeing and mental 
health. Scientists would benefit from 
mentors encouraging them to seek 
support and encouragement as we 
engage in our demanding work. Brenda 
brought this encouragement with 
warmth and positivity. Thanks, Brenda!

A Fond Farewell to Brenda Hanning

(continued on page 4)
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A Fond Farewell to Brenda Hanning
(continued from page 3)

Mark Bayfield
Associate Professor, York University and

previously the first course director for
the NICHD postbaccalaureate course

Brenda helped us in so many ways. She recognized 
that NICHD postdocs needed teaching experience 
and that IRTA fellows needed guidance analyzing 
primary literature, and from that we brainstormed 
the NICHD post baccalaureate course. That 
teaching experience was such a big help as we 
then applied for academic positions.

Ashleigh Bouchelion
Howard University College of Medicine Class of 2017

Brenda Hanning is such a special person. I called 
her my "angel" because if it weren't for her, I 
wouldn't have been able to conduct my thesis 
work for my Ph.D. at the NIH. I felt like I received 
so much support from her during the three years 
that I was there. She was always there when I 
called or emailed. She was always there to give 
sound advice. She was always there to comfort. 
I will always have a special place in my heart for 
Ms. Hanning. I hope you have a wonderful next 
chapter, Brenda!

Joan C. Han
Director, Pediatric Obesity Program, Le Bonheur 

Children's Hospital and Associate Professor, 
Division of Pediatric Endocrinology, Department 

of Pediatrics, University of Tennessee
Health Science Center

Brenda’s smile and words of encouragement 
are some of the brightest memories of my 
decade at the NIH. Brenda provided cheer and 
helpful advice during my years as a pediatric 
endocrinology fellow, and then she assisted 
me in my transition to senior clinical fellow and 
eventually Assistant Clinical Investigator. When 
I finally launched into my first faculty position 
outside of the NIH, Brenda was also there to 
guide and support me and I will be forever 
grateful for her kindness.

Stephanie M. Cologna
Assistant Professor, Department of Chemistry, 

University of Illinois at Chicago

Brenda had such a positive impact on me 
during my time at NIH. She always encouraged 
me to excel and provided an abundance of 
resources. Wishing her all the best.

(continued on page 5)
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A Fond Farewell to Brenda Hanning
(continued from page 4)

Matthew Kohn
Science Officer, NYSTEM, New York 

State Department of Health

Brenda was a great asset to all 
the trainees at NICHD, we were 
lucky to have her. She was always 
supportive and a kind and caring 
friend. Her retirement is a real loss 
to NIH.

Kevin Francis
Assistant Scientist, The Children’s 
Health Research Center, Sanford 

Research and Assistant Professor, 
Department of Pediatrics, Sanford 

School of Medicine, University of 
South Dakota

Brenda was such an incredible asset 
for me during my time at NICHD. 
The career development initiatives 
developed by Brenda and the Office 
of Education were an instrumental 
component to my postdoctoral 
training. I truly believe Brenda’s 
guidance and support were critical 
to my professional success. It’s hard 
to imagine NICHD without her, but 
I wish her the absolute best in her 
very well deserved retirement.

Claudia Gebert
Biologist, NICHD, Karl Pfeifer’s Lab 

When I started as a postdoctoral visiting 
fellow in 2005, Brenda had just become the 
director of the Office of Education at NICHD 
but was already known as the go-to person 
in all career related matters. Her support 
in the pursuit of even the most out of the 
ordinary career choice felt empowering and 
she encouraged me to explore and even create 
new alternative career opportunities. Brenda 
was known to know every postdoctoral fellow, 
graduate student, and postbac in NICHD by 
name and she always had time to check in 
when she randomly met one of us on campus. 
Coming from abroad and suffering culture 
shock, Brenda made me feel welcome on the 
huge NIH campus and its often intimidating 
scientific world, and without her knowing, she 
was an anchor in the transition to feeling at 
home in this country. Thank you, Brenda!

Silviya Zustiak
Assistant Professor, Saint Louis University

Brenda involved me as a regular contributor 
to the NICHD Newsletter. This involvement has 
been very beneficial for me as it connected 
me to the community, exposed me to other 
committees and fellows activities, and boosted 
my confidence as a writer.

(continued on page 6)
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A Fond Farewell to Brenda Hanning
(continued from page 5)

Rachel Heimeier
School Principal, Internationella
Engelska Gymnasiet Södermalm

Greetings from Stockholm!

When I received the news that Brenda Hanning will retire in the end of 
December, it brought back fond memories of my time at NICHD, and of 
course of Brenda!

What a lady! As a visiting postdoctoral fellow from Australia, my time 
spent at NICHD spanned 2004 – 2009. I met Brenda by being part of 
organizing the NICHD retreats for fellows. We were both new to NICHD 
in our roles. Brenda has such a friendly, calm approach to all things 
and at that time it was a real inspiration for me to work with her. She 
represented a strong-willed, intelligent and resourceful career-minded 
woman that she instantly and unexpectedly became an informal mentor 
and coach to me.  

During my time working with Brenda on the retreats and with summer 
student projects, we discussed science, education, and well a number of 
other issues related to careers and development. She has been my go 
to person for references and interview prep in all my career moves. She 
encouraged my acceptance of the Vinnmer Marie Curie Vinnova mobility 
grant for young professional female researchers to Karolinska Institutet 
in Sweden in 2009. In 2011, when I decided to move away from research 
and into education as a School Principal, Brenda was extremely 
supportive in that decision and encouraged me to combine my skills 
and passion to education and working with people. In line with Brenda’s 
wise words, I continue to promote sciences in schools and with outside 
communities such as Karolinska Institutet, Stockholms Universitet, and 
European Synchroton Radiation Facility in Grenoble. Thank you Brenda 
for your inspiration and continued support! Wishing you all the best in 
your retirement! Come and visit now you have some time ☺
Best wishes / Med vänlig hälsning

(continued on page 7)
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A Fond Farewell to Brenda Hanning
(continued from page 6)

Margaret Ochocinska
Program Director, NIH in the

National Heart, Lung, and Blood Institute

Brenda Hanning was a great source of 
support for my professional development 
during my time as a postdoctoral fellow at 
NICHD. She offered excellent advice and 
was always willing to help postdoctoral 
fellows with their career aspirations and 
was a great source of encouragement 
throughout the process.

Elena Makareeva
Staff Scientist, Section on

Physical Biochemistry, NICHD

I am so grateful that I met Brenda during 
my postdoc years at NICHD. Over the 
years, she helped me and multiple 
postbac and graduate students from our 
lab. NICHD wouldn’t be the same without 
Brenda!

Kristofor Langlais
Program Lead, Genomics and Health, Office 
of Science Policy, Office of the Director, NIH

There is no doubt that I wouldn't be where 
I am without Brenda. She helped to expand 
my network, gave me the chance to lead, 
and opened doors to an experience that 
was critical for my transition to science 
policy.

Dan Sackett
Senior Researcher

and Trainee Advisor, NICHD

Brenda has been for me an understanding 
friend, an always reliable resource, a guide, 
and a ready smile for many years. She has 
helped me, and been an invaluable advisor 
for students that have worked with me. Of 
course, I wish her all the best in her new 
adventures, but will acutely miss her ready 
counsel and reliable smile.
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A Fond Farewell to Brenda Hanning
(continued from page 7)
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Join us for a celebration to 
honor Brenda Hanning upon 
her retirement from the NIH 

When: Friday, January 6, 2017, from 3:30 to 4:30 pm 

Where: Building 31, Room 6C7 (C-wing, 6th floor) 

Light refreshments will be served. 
Contact Francie Kitzmiller at franciek@mail.nih.gov or Sara King at mullends@mail.nih.gov with questions. 
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The Questions That Drive You:
Dr. Katie Drerup Joins the NICHD
By Gülcan Akgül, PhD

As a student at Bowling Green University 
in Ohio, Dr. Catherine “Katie” Drerup 
was preparing to go to veterinary school 
when she welcomed an unexpected 
opportunity to change her entire 
career—and maybe life. Drerup attended 
an animal behavior class from Dr. 
Robert Huber, who studied serotonergic 
modulation of aggressive behavior in 
crayfish. When Drerup got involved in 
Huber’s research, she was completely 
blown away by science. She turned down 
her vet school offer and joined the Huber 
lab for a master’s project. And that, she 
said, is where her story began.

After finishing her master’s degree, 
Drerup joined the Neuroscience Program 
at Northwestern University in Chicago 
for graduate work with Dr. Jill A. Morris, 
who by that time had already cloned 
and characterized the infamous Disc1 
gene, a mouse ortholog of human DISC1 
(Disrupted-in-Schizophrenia 1). Drerup 
analyzed the functional significance 
of the zebrafish Disc1 ortholog during 
development. In addition, she cloned 
and characterized the Ndel1 and Lis1 
genes in zebrafish, which code for 
the molecules in the dynein/dynactin 
complex responsible for neuronal 
migration in the developing cortex. 

Even after a productive PhD experience, 
Dr. Drerup hesitated to pursue a 
research career in academia. “Towards 
the end of my PhD, I was really 
considering if I wanted to continue in 

science. My [doctoral] lab 
was new to developmental 
biology, and it took a 
while to get things off 
the ground, although we 
had collaborations with 
wonderful scientists. I was 
wondering if I was cut out 
for it, given my struggle 
accepting the failure rate. 
My advisor encouraged me 
to do a postdoc to be sure. 
My time as a postdoc was 
wonderful, and my advisor 
was supportive in so many 
ways. It gave me the time I needed 
to grow as a researcher and find the 
questions that really drive me. After less 
than a year, I was confident that I wanted 
to pursue a career in science.” 

For her postdoctoral research, Drerup 
worked with Dr. Alex Nechiporuk in the 
Department of Cell and Developmental 
Biology at the Oregon Health and 
Science University. She continued to use 
zebrafish as a model organism due to 
its advantages in genetic manipulations 
and imaging, and she dug deeper into 
the molecular and cellular biology 
of intracellular transport in neurons. 
Several years into her postdoctoral work, 
Drerup received the prestigious NIH 
Pathway to Independence Award (K99/
R00). 

In addition to striving to be a good 
mentor and perform high-level research, 

(continued on page 10)

Dr. Katie Drerup
PHOTO: JEREMY SWAN
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Dr. Katie Drerup Joins the NICHD
(continued from page 9)

Drerup also feels a responsibility to represent and support women 
in science. She serves on the Women Scientists Advisors (WSA) 
Committee at NICHD to help deal with gender-related issues. One 
particular area of interest for her is the “drop-off point” that exists 
for women in science. “Increasing numbers of women are going to 
graduate school but the same proportion does not progress to the 
level of principal investigator. The reasons behind this are unclear but 
need attention.” 

For Drerup, her research track started with the study of behavior and 
eventually transitioned into the microscopic world of cell biology. Now, 
she hopes her own lab can encompass all levels. Drerup sees biology 
in two ways: from a cell biology perspective and a whole organism 
perspective and hopes to interact with the rich neuroscience faculty at 
NIH to enhance her ability to bridge this gap. 

Drerup’s research will focus on cargo transport in axons with a 
particular focus on retrograde movement governed by the dynein/
dynactin complex. She wants to understand how unique cargos attach 
to this single motor protein complex for transport. In addition to being 
interested in understanding the mechanisms of cargo-motor interaction, 
she is interested in studying the similarities and differences in this 
cellular mechanism in sensory versus motor neurons. Even though 
research is her priority, Drerup is excited about additional professional 
opportunities, such as teaching and outreach, for NIH investigators.

Drerup is at the beginning of her independent research, but she 
pointed out that her training thus far has given her the skill set 
necessary for this career, including accepting the natural experimental 
failure rate, managing several different projects at the same time, and 
the high pressure/high paced lifestyle in general. “It becomes natural 
after a while and you start thinking this is not so hard to manage 
really…you work because you want to be here. Some days will be 
miserable, an experiment you were really excited about fails for some 
inexplicable reason, but it is the underlying questions—they drive you.”
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The Arts: Bending the Space-Time Continuum
By Jeremy Swan 

Ever wanted to control time like Marvel 
Comics’ Dr. Strange? While you can’t go 
back in time (creating alternate universes 
in the process), you can control time in 
extraordinary ways with data images. 

Time-lapse and slow motion are extremely useful techniques for understanding 
the world around us and under the microscope. High-speed photography is 
often used to create slow motion effects, which is useful for understanding the 
mechanics of motility. For example, the Horse in Motion by Eadweard Muybridge, 
ca. 1886, helped usher in an era of animation and walk cycles. Or we better 
understand the zebrafish startle response from slow motion videos from the 
Burgess lab. Time-lapse, on the other hand, appears to speed up time—such 
as in Fertilization and Development of the Sea Urchin Egg by Julius Ries, an early 
time-lapse microcinematographic film from 1907.  

These age old techniques are easier than ever to create and distribute. The next 
few articles in “The Arts” column will provide several approaches to enable you 
to directly control time (in video)! 

One straightforward approach involves the use of Photoshop, which is a staple 
application for photographers and also fairly common in imaging circles. There 
has been a proliferation of specialized, simple apps for capturing and assembling 
time lapses for photographers using digital single lens reflex cameras (SLRs), 
mobile phones, or connected computers. Many of these are free, inexpensive, or 
easy to use but also have limited capabilities and complexity, such as cropping, 
image manipulation, export dimensions and format. Here, we will focus for now 
on using Photoshop to create movies, which gives you a good deal of control and 
flexibility.

(continued on page 12)

VOLUME 7 • ISSUE 79 • DECEMBER 2016

11



The Arts: Bending the Space-Time Continuum
(continued from page 11)

HOW TO CREATE A SIMPLE TIME-LAPSE MOVIE USING PHOTOSHOP:

Preparing your images (based on second half of this tutorial: https://www.
youtube.com/watch?v=-ZHXXsZ4K8g): These instructions are based 

on Photoshop CC. Your own 
workspace may differ. Please 
contact Jeremy Swan with 
questions: swanjere@mail.
nih.gov

1. Collect sequentially named image files together in a folder 
(with no gaps in the sequence numbers)

2. Launch Photoshop and 
click Window > Timeline 

3. Create new file:

a. Click Edit > New File

b Change Document Preset to 
“Film and Video”

c. Change Size to "HDTV 1080P 29.97"

4. Click “Create Video Timeline” 
(bottom-center of window)

5. Set Timeline Framerate:

a.
Click dropdown menu 
in lower right hand side 
of window

b.
Click "Set Timeline 
Frame Rate" and 
choose 29.97 FPS

(continued on page 13)
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To follow along with this 
tutorial, you can download 
8,500 microscope 
images (3.8GB), which 
were provided by Daniel 
Castranova from the 
Weinstein Lab, NICHD. 
These images represent the 
first 24 hours of a fertilized 
zebrafish egg developing. 

The full 48 hours can be 
viewed here: zebrafish-
timelapse.mp4 (2.2GB).

(continued from page 12)

6. Add Video Layer:

a. Click Layer > Video Layers > 
New Video from File

b. Navigate to folder containing 
images (named sequentially)

c. Choose first image 
in sequence (note: 
problems will arise 
if there is a gap or 
deviation in sequence)

7. Prepare Layers:

a. Click on “Layer 0”  to select 
it and press the delete key 
to remove it (or right-click 
and select "Delete Layer")

b. Right click (⌘  on  or Ctrl on PC + 
click) on Layer 1 (the layer containing 
the photo sequence) and select 
“Convert to Smart Object”

The Arts: Bending the Space-Time Continuum

(continued on page 14)
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The Arts: Bending the Space-Time Continuum
(continued from page 13)

8. Transform (non-destructively)

a. To enter transform mode, press: ⌘ /Ctrl + T key b. To zoom out, press: 
⌘ /Ctrl + 0 (zero) key

c. Press and hold shift 
and grab corner to 
scale the layer to 
the frame 

d. Decide whether 
to crop part of the 
image in order to 
accommodate the 
frame size. If part 
of the frame is left 
empty, that portion 
will be rendered as 
black.

9. Export video:

a. Click File > Export > Render Video

b. Select folder to export to (generally not 
in the source images folder)

c. Choose Adobe Media Encoder 
with these settings:
H.264, High Quality, 1920x1080, 
29.97 fps, progressive, 1.0

d. Click “Render” and then view 
resulting video
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Meet Our New Fellows
Please join The NICHD Connection in welcoming the following fellows to the NICHD family:

Zelia Ferreira Worman
IRTA Postdoctoral Fellow

Home city and country: Porto, Portugal
Degree institution: University of Porto, Portugal with a 

two-year special volunteer appointment at NHGRI (Eric 
Green’s lab) and a six-month visiting graduate student 
appointment at Cornell University (Andrew G. Clark’s lab)

NICHD Mentor: Dr. Henry Levin
Area of research: I study the potential role of polymorphic 

transposable elements in the development of mental 
illness. I am also the lead chair of the Service and 
Outreach subcommittee for FelCom.

Lingyu Bao
Graduate student

Home city and country: Xi’an, China
Degree institution: PhD student, Xi’an Jiaotong University 

(China)
NICHD Mentor: Dr. Yun-bo Shi
Area of research: I study the molecular factors involved in 

the stem cell development of intestine using the frog 
and mouse line.

Shelby Newsad
IRTA Postbaccalaureate Fellow

Home city and country: Beverly, Ohio 
Degree institution: The Ohio State University
NICHD Mentor: Dr. Michaela Serpe
Area of research: I study the proteins involved in the 

clustering of synaptic factors using model organism 
Drosophila melanogaster.
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Three-minute Talks (TmT) Competition 2017

NOW SEEKING FELLOWS: SCIENCE COMMUNICATION TRAINING 
AND AWARDS PROGRAM

Learn how to explain your research, in three minutes or less, in a way that’s 
meaningful to a broad scientific audience.

“
”

BENEFITS OF PARTICIPATION
» Professional training in speech development and presentation delivery
» One-on-one coaching and feedback in a supportive environment
» The opportunity to showcase your research for NICHD leaders and the public
» The chance to win up to $1,000 for approved training or travel to a scientific 

meeting
» For finalists: A professionally produced video of your talk for NICHD 

promotional efforts and your own use

Participating in the NICHD Three-minute Talk Competition was electrifying. 
All the participants created dynamic talks to showcase their research; 
it was a thrill to be a part of this competition. The workshops helped 
me tailor my research into an engaging and relevant story, which I can 
now summon when talking with researchers at conferences, potential 
collaborators, and members of the general public. The one-on-one 
practice sessions strengthened my presentation delivery. In addition, the 
video clip of my talk is a remarkable tool to broadcast my research to the 
community. I encourage others wishing to energize people with their own 
research to participate in this competition.

~Dr. Kathryn Tabor, 2015 1st place winner (check out her winning video)

(continued on page 17)
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https://www.youtube.com/watch?v=b6POjZMaC_w&feature=youtube


Three-minute Talks (TmT) Competition 2017
(continued from page 16)

2017 PROGRAM TIMELINE AND DETAILS
Fellows should be committed to participating in the full TmT Competition program, including the 
workshop trainings, NICHD TmT competition, and—if selected as finalists—the NIH TmT competition.

FRIDAY, FEBRUARY 3 DEADLINE TO ENTER
To enter, email your completed submission form to yvette.
pittman@nih.gov, which includes the title of your talk and 
a brief description of your research (2–3 sentences max).

Up to 15 DIR fellows (predoctoral, postdoctoral, visiting, 
and clinical) will be invited to join the TmT Competition 
program. All 2016 finalists are also welcome to participate.

Submission form can be found at the Three-Minute Talks 
Webpage

FEBRUARY 6 “SPEAKING ABOUT SCIENCE” WORKSHOP
Led by public speaking coach Scott Morgan. This workshop 
will offer tips on storytelling and delivery, speaking in plain 
language, and creating an effective visual aid.

MARCH 10 AND 22 INDIVIDUAL COACHING SESSIONS
You will have the opportunity to participate in a group 
coaching session with Scott Morgan and up to two one-on-
one coaching sessions with NICHD communications staff. 
These practice sessions will provide you with additional 
help and feedback on speech development and delivery.

APRIL 11 NICHD TmT COMPETITION*
Of the NICHD’s 15 contestants, five finalists will advance to 
the next round, be awarded $500 for approved training or 
travel, and the opportunity to present their three-minute 
talks at the 13th Annual Fellows Retreat on May 1st.

JUNE 29 NICHD TmT COMPETITION*
Of all NIH finalists, 1st, 2nd, and 3rd place winners will 
receive an additional $500 training/travel support and the 
opportunity to have their talk professionally produced for 
video.

*Competition rules and judging criteria are available at
https://science.nichd.nih.gov/confluence/display/fellows/Three-Minute+Talks
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Life Outside Lab:
Talking Science 
on the Other 
Side of the 
Country
Postdoctoral Fellow Dr. 
Gülcan Akgül (McBain lab) 
chats with a conference 
attendee during the 
Society for Neuroscience 
Annual Meeting held 
November 12-16, 2016, in 
San Diego, California.
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NICHD DIR Year in Review for 2016
A look back at the numerous accomplishments belonging to fellows in the 
NICHD Division of Intramural Research (DIR) during 2016:

The NICHD DIR held the Twelfth Annual Meeting of Postdoctoral, 
Clinical, and Visiting Fellows and Graduate Students at the National 
Museum of the American Indian on April 22, 2016. Keynote speakers 
included Eric Betzig, 2014 Nobel Prize Laureate in Chemistry and group 
leader at HHMI’s Janelia Research Campus, and Dr. Jorge Cham, the 
creator of PhD Comics.

Drs. Sarah Cohen and Alex Valm (Lippincott-Schwartz Lab) won the 
2016 fellows retreat image competition with their image “Multicolor 
organelles in an African Green Monkey kidney cell.”

Greg Marquart (Burgess Lab) won the 2016 Scientific Retreat Image 
competition with his image “18 Fish in 1: Expression patterns from18 
larval zebrafish show distinct subsets of neurons within the brain.”

Dr. Shlomo Krispin, nominated by postbac fellow Margaret Burns, 
received the NICHD Fellow Mentor of the Year award. Dr. Julian Lui 
(Staff Scientist), nominated by postbac fellow Michal Ad, received the 
NICHD Investigator Mentor of the Year award.

Twenty NICHD fellows received the 2017 Fellows Award for Research 
Excellence at the 30th Annual NIH Research Festival (complete list here) 

During the 2016 Postbac Poster Day, a total of 14 NICHD postbacs 
received an overall top 20 percent poster award (NIH-wide) or one of 
the three “Best Poster” NICHD awards (complete list here). 

Dr. Alex Szatmary, postdoctoral fellow in the Nossal lab, placed third 
in the 2016 Three-minute-Talk (TmT) Competition.

Dezmond C. Taylor-Douglas, graduate student in the Yanovski lab, 
was selected for an oral presentation at the 2016 NIH Graduate 
Student Symposium. 

(continued on page 20)
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NICHD DIR Year in Review for 2016
(continued from page 19)

Dr. Neelam Dabas Sen, postdoctoral fellow in the Hinnebusch 
lab, received the 2016 WSA Scholar Award from the NIH Women 
Scientist Advisory Committee. 

Dr. Parmit Kumar Singh, postdoctoral fellow in the Levin lab, 
received the 2016 Intramural AIDS Research Fellowship and the 
18th Annual Norman P. Salzman Memorial Award in Virology. 

Dr. Dan Benjamini, postdoctoral fellow in the Basser lab, won 
the 2016 Giulio Cesare Borgia Prize at the 13th International 
Bologna Conference Magnetic Resonance in Porous Media.  

A big THANK YOU to all of our 2016 newsletter contributors (in no 
particular order): 

Courtney Kurtyka, Afrouz Anderson, Si Young Lee, Yvette 
Pittman, Marina Venero Galanternik, Jeremy Swan, Nicki Swan, 
Brenda Hanning, Daniel Flores, Suna Gulay, Pushpanathan 
Muthuirulan, Sudhir Rai, Smriti Aryal, Arnab Datta, Uma Neelathi, 
Neelam Dabas Sen, Alessandro Albano, Libby Barksdale, Melissa 
Cunningham, Thomas Miller, Mahua Mukhopadhyay, Ramona 
Neunuebel, Margarito Rojas, Marci Rosenberg, Ajay Sharma, 
Lauren Wooddell, Mihail Zilbermint, Sourav Haldar, Gülcan Akgül, 
Anna Roberts-Pilgrim, Amy Palin, Marina Venero Galanternik, 
Laura Gorrell, Raghuveer Kavarthapu, Vivek Mahadevan, Fardin 
Ghobakhlou, Amra Saric, Zelia Ferreira Worman, Lingyu Bao, 
Shelby Newsad, Parmit Kumar Singh, Dan Benjamini, Greg Palardy

Please submit your accomplishments for publication in the 
newsletter throughout the year to Shana.Spindler@gmail.com.
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December Announcements
SAVE THE DATE! BRENDA HANNING’S RETIREMENT CELEBRATION, JANUARY 6, 2017

Building 31, Room 6C6, 3:30 – 4:30 p.m.

Join us for a celebration to honor Brenda Hanning upon her retirement from the NIH. Light 
refreshments will be served. Please contact Francie Kitzmiller at franciek@mail.nih.gov or 
Sara King at mullends@mail.nih.gov with questions.

CALLING ALL FELLOWS OF NICHD—IT'S IMAGE COMPETITION TIME!
The 13th Annual NICHD Fellows Meeting will be held on May 1, 2017, and we are looking for an 
image to feature.

The winning image, chosen by the Retreat Steering Committee, 
will be showcased on the retreat website, on posters, and 
used as the front cover of the event program. Also, to highlight 
everyone’s imagery, all submissions we receive will be used to 
produce a collage posted on the 2017 retreat website. You can 
always take a look at the image submissions from previous 
years at http://retreat.nichd.nih.gov.

In addition to image resolution and quality, selection criteria 
include the relevance to our institute’s mission and artistic 
view of the image. All submissions (at the highest possible 
resolution) should be sent to Nicki Swan (jonasnic@mail.nih.
gov) by Friday, January 13th, with a brief caption for the image.

[At right, last year's winning image by Drs. Sarah Cohen and Alex Valm, Lippincott-Schwartz Lab]
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December Events
MONDAY, DECEMBER 5, 10 AM – 12 NOON

Chalk Talks Workshop

Chalk Talks are an increasingly important 
component of science communication. 
Once reserved for academic interviews, 
they are now common in industry and for 
tenure-track positions, such as the NIH 
Earl Stadtman Investigators program. This 
workshop will focus on the components 
that make an effective chalk talk and 
provide a safe place to practice new skills.

Topics include:
» Connection to job talks
» Relevance to faculty
» What to draw on the white/blackboard
» Levels of detail
» Question anticipation
» Tone and delivery

To learn about the next Chalk Talk 
Workshop opportunity, please contact 
Yvette Pittman (yvette.pittman@nih.gov).
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